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Introduction
Welcome to AccuRev, the best software change and configuration management (SCCM) system avail-
able today.

Highlights of this Release
AccuRev Version 4.9 provides several enhancements and bug fixes including:

• A new license manager that supports AccuRev floating licenses and simplified replication 
server licensing.

• A new GUI Update Preview filter in the Searches pane, which shows changes that would 
happen if you updated, and from which you can execute commands such as diff and merge on 
selected elements.

• Enhancements to the Deep Overlap filter, including:

• an optimization checkbox to stop searching for overlaps beyond a time-basis stream

• display of (kept) status after a merge so that you can promote the element

• removal of the element from the filter display after it has been promoted

• The ability to peform Revert by Change Package operations from a workspace

• The ability to specify a date or transaction id (“-t”) for the stat and pop commands

• The ability to pop an element without its directory structure

• More robust handling of long pathnames on Windows.

• A new Help system for AccuRev manuals featuring cross-document search capabilities.

• Better handling of issue numbers by the server_post_promote trigger for cross-promotes

• Better handling by GUI merge of files containing characters outside of your current encoding 
preference. The GUI now warns when it cannot merge a file that contains binary or Unicode 
content.  Also a preference was added for ISO-8859-1 encoding on non-Windows platforms 
which can merge files with binary content correctly

• Enhancements to AccuWorkflow (a new way to more easily associate an existing stage with 
an existing transition) and its documentation (a new Quick Start section).

• New options to install the AccuRev Web UI server when you use the AccuRev Installation 
Wizard in Custom mode.

• A new clickable Issue link to the Web UI, in the AccuWork Issue Edit form.

• Removal of the "indirect ancestry" issue icon and tooltip from the GUI to reduce confusion.

• Improvements to the stat command, including better handling of deep overlaps and better 
handling of elements that have been renamed in the backing stream.
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• Improvements to the hist command, including a new -fi (“issues related to a version at the 
time of a transaction”) option, and more info (cpk add and and cpk remove transactions) 
returned by the -fv option, plus new XML tags and attributes to support these enhancements.

• Better handling of LDAP authentication.

• Improved merge behavior when the basis and common ancestor are the same real version, and 
the workspace and merge-from version share the same backing stream.

• Better handling by update of the “moveaside” directory

• A fix so that diff and update now see changes from a stream with a cross-link to a stream 
hierarchy with a time basis

• The ability to change the case sensitivity of a depot

• Correct display of files and issues in the GUI for Revert by Transaction, Revert by Change 
Package, and Show Active Issue operations.

For details about the specific changes introduced in this release, please see AccuRev 4.9 Release 
Notes on page 16.

To install AccuRev, please see AccuRev Installation Notes on page 3.
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AccuRev Installation Notes

Overview
This chapter provides information about installing or upgrading AccuRev Configuration 
Management software at your site. Additional information can be found in the “Quick 
Evaluation” chapters in AccuRev Technical Notes.

Installation of AccuRev Configuration Management software involves downloading an 
installation program from the AccuRev Web site and running it on the target machine. 

The software must be installed on each machine separately. There is no batch install capability, 
but you can perform a non-interactive installation on UNIX or Linux machines, which is driven 
by a simple configuration file. See UNIX/Linux: Unattended Installation for those instructions.

Note: If you are an existing AccuRev user, you should note that two major changes have been 
introduced in the 4.9 release of the AccuRev installer:

• The addition of the new Reprise license manager (see Enabling the Reprise License Manager 
on page 12)

• The option to install the AccuRev Web UI server (see Installing the Web UI Server on 
page 10). (The standalone Web UI installation is still available, but this new option allows you 
to install the Web UI server as part of the main AccuRev installation.)

Prerequisites
Before proceeding, review the following prerequisites:

Plan Machine Usage
One machine at your site should be the AccuRev Server machine — the one that runs the 
AccuRev Server process and hosts the AccuRev data repository. Other machines can access the 
AccuRev Server after installing the AccuRev Client software. You can also have one or more 
replication servers.

Licenses
You must have a valid license file, provided to you by AccuRev. Note that this release offers the 
option of using a new license server based on Reprise License Manager software. See Enabling 
the Reprise License Manager on page 12 for more details.

Compatibility with Previous Versions of AccuRev
If you are upgrading, please note that AccuRev Version 4.9 is not compatible with any prior 
AccuRev releases. If you are upgrading from a pre-4.9 release of AccuRev, you must upgrade the 
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machine that runs the AccuRev Server software, along with all the machines that run AccuRev 
Client software.

No explicit conversion is required to bring the AccuRev data repository from any prior level to 
Version 4.9. When you install Version 4.9 on the machine that runs the AccuRev Server software 
(this machine also hosts the data repository), the repository will be upgraded automatically, if 
necessary.

(UNIX/Linux only) Workaround for Java Runtime Library Problems
The AccuRev Installation Wizard and the AccuRev GUI fail on some UNIX/Linux platforms 
because of Java library problems. Use this procedure to work around these problems:

1. Run the Installation Wizard with environment variable LIBXCB_ALLOW_SLOPPY_LOCK set to 
the value 1.

2. Fix the runtime library file in the new AccuRev installation area:
> cd <AccuRev-installation-dir>/jre/lib/i386/xawt
> sed -i 's/XINERAMA/FAKEEXTN/g' ./libmawt.so

Download the AccuRev Installation Package
On the Downloads page of the AccuRev, Inc. Web site (http://www.accurev.com/
download.htm), download the appropriate AccuRev installation package for your operating 
system. Make a note of the directory you saved the file to (referred to as installer-loc 
throughout this document).

• If the file you downloaded is the Wizard itself (Windows:.exe file, UNIX/Linux: .bin file), 
then you are ready to run the Wizard.

• If you downloaded a compressed package (.zip or .gz file), first extract the Wizard from the 
package. Many extraction tools are freely available. There are handy links to such tools on the 
Downloads page; and the unzip and gunzip programs are standard on many UNIX/Linux 
systems.

Review Platform Notes
Before proceeding with the installation, review Platform Support Notes on page 12

Determine the Type of Installation You Require
The AccuRev installation provides you with several options:

• Are you performing a new installation, or an upgrade to an existing installation?

• Are you installing a server, or just a client?

Generic Name Actual Name
installer-loc
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• Do you wish to install the optional AccuRev Web UI server?

• Do you want to perform a “Typical” installation, where the AccuRev Installation Wizard 
makes many default decisions for you, or do you wish to perform a “Custom” installation, 
where the Wizard prompts you for guidance at every step?

Based on the answers to these questions, proceed to the appropriate sections below:

• Windows: Installing an AccuRev Server on page 5

• UNIX/Linux: Installing an AccuRev Server on page 5

• Installing or Upgrading an AccuRev Client Only on page 7

• Upgrading an AccuRev Server on page 7

• Installing the Web UI Server on page 10

• Installing the Software — “Custom” Installations on page 10

Installing the Software — “Typical” Installations
In most cases, the “Typical” installation is the best option to choose. (One exception is if you are 
installing the AccuRev Web UI for the first time. In this case, see Installing the Web UI Server on 
page 10 in the Custom Installation section.) The AccuRev Installation Wizard looks for an 
existing installation, and if it finds one, performs an upgrade. Upgrades made in Typical mode 
prompt you for little or no information, using default values wherever possible.

If the Wizard does not find an existing installation, it prompts you to specify whether you want 
your client to connect to the current machine or another host. If you specify “this machine”, the 
Wizard installs an AccuRev server as well as a client. If you specify “another host”, it assumes 
that you need to install just a client, and proceeds.

The sections below assume “Typical” installations. For information about “Custom” installations, 
see Installing the Software — “Custom” Installations on page 10.

Windows: Installing an AccuRev Server
1. Navigate to the installer-loc directory and locate the downloaded installer.

2. Double-click the installer’s icon to launch it, or enter the installer name on the command line 
(substituting the appropriate digits for the Ns):

AccuRev_N_N_N_Windows.exe

3. Select Typical as the installation type and see the Installation Wizard Notes for “Typical” 
Installations to proceed through the remainder of the Wizard.

UNIX/Linux: Installing an AccuRev Server
Note: It is a UNIX/Linux “best practice” to minimize the number of programs that run under the 
root user identity. When the procedure below has been completed, the AccuRev Server will be 
configured to run without root privileges.
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1. Become the root user.

2. Create a new identity for the AccuRev Server to run under. For this procedure, we assume that 
you create this identity:

username: acserver
groupname: acservergrp
home directory: /home/acserver

3. Create a directory in which the AccuRev client and server software will be installed, along 
with the AccuRev data repository. (And make sure to leave this directory empty.) For this 
procedure, we assume that you create this directory:

installation directory: /opt/accurev

IMPORTANT: You must select a directory that is local to your machine, not a networked or 
mounted drive. The AccuRev data repository and the AccuRev Server must be located on the 
same machine.

4. Change the ownership of the installation directory:
chown acserver:acservergrp /opt/accurev

5. Switch to the new user identity, acserver.

6. Navigate to the installer-loc directory and locate the downloaded installer.

7. Double-click the installer’s icon to launch it, or enter the installer name on the command line:
sh AccuRevInstall.bin (graphical Wizard)
sh AccuRevInstall.bin -i console (text-based Wizard)

For a non-interactive alternative to the Wizard, see UNIX/Linux: Unattended Installation on 
page 9.

8. Select Typical as the installation type and see the Installation Wizard Notes for “Typical” 
Installations to proceed through the remainder of the Wizard.

Starting the AccuRev Server Automatically

When the Wizard completes, AccuRev is fully installed on your machine, and is ready to use. By 
default, the AccuRev Server process can be started and stopped manually by user acserver, with 
these commands:

/opt/accurev/bin/acserverctl start
/opt/accurev/bin/acserverctl stop

If you would like the AccuRev Server to be started automatically at system boot-time, follow 
these additional steps:

1. Edit the server configuration file (/opt/accurev/bin/acserver.cnf) as follows:
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This will configure the boot-time script that starts the AccuRev Server (see Step 4) to set the 
Server’s user identity, using setuid.

2. Stop the newly installed AccuRev Server:
/opt/accurev/bin/acserverctl stop

3. Become the root user.

4. Using the files in directory /opt/accurev/extras/unix, set up the boot-time scripts to start the 
AccuRev Server.

5. Reboot the machine.

Installing or Upgrading an AccuRev Client Only
If you are upgrading, you don’t need to uninstall any existing software. The AccuRev Installation 
Wizard lets you preserve your development data and configuration files, and installs the upgrade 
in the same place as your existing version.

1. Navigate to the installer-loc directory and locate the downloaded installer.

2. Double-click the installer’s icon to launch it, or enter the installer name on the command line 
(substituting the appropriate digits for the Ns):
AccuRev_N_N_N_Windows.exe (Windows)
AccuRevInstall.app (OS X)
sh AccuRevInstall.bin (UNIX/Linux, graphical Wizard)
sh AccuRevInstall.bin -i console (UNIX/Linux, text-based Wizard)

3. Select Typical as the installation type and see the Installation Wizard Notes for “Typical” 
Installations to proceed through the remainder of the Wizard.

Note: Using the Typical option for upgrades will upgrade the current AccuRev installation to 
the new version using the default options. If you need to change the type of installation, or 
alter any installation options during the upgrade, choose the Custom installation type.

Upgrading an AccuRev Server
You don’t need to uninstall any existing software. The AccuRev Installation Wizard lets you 
preserve your development data and configuration files, and installs the upgrade in the same place 
as your existing version. The data repository is automatically upgraded to the new release level.

1. Stop the AccuRev Server process.

• Windows:
net stop accurev
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• UNIX/Linux:
cd <AccuRev-bin-directory>
./acserverctl stop

2. Perform a full backup of the AccuRev data repository. For detailed instructions, see the 
section titled Backing Up the Repository (on page 3 of the AccuRev Administrator’s Guide).

3. Navigate to the installer-loc directory and locate the downloaded installer.

4. Double-click the installer’s icon to launch it, or enter the installer name on the command line:
AccuRev_N_N_N_Windows.exe (Windows)
sh AccuRevInstall.bin (UNIX/Linux, graphical Wizard)
sh AccuRevInstall.bin -i console (UNIX/Linux, text-based Wizard)

5. Select Typical as the installation type and see the Installation Wizard Notes for “Typical” 
Installations to proceed through the remainder of the Wizard.

6. Verify that the new AccuRev Server process has been started, by running this command:
accurev info

7. If you need to start the AccuRev Server process manually, use these commands:

• Windows:
net start accurev

• UNIX/Linux:
cd <AccuRev-bin-directory>
./acserverctl start

Installation Wizard Notes for “Typical” Installations
Use these notes to determine which installer options to choose for your installation type.

• Under Configure: Set Host and Port:

• If you wish to install the AccuRev Server on this machine, or create a test installation, 
select this machine. The wizard will install both the client and server software.

• For all other install types, select another host and enter the hostname and IP port number 
of the AccuRev Server to connect to.

• If you are performing a console installation using the text-based Wizard, be careful to enter 
only numeric characters for the port number. If you enter non-numeric characters, the Wizard 
displays Java-level error data and proceeds to the next prompt. Enter back at that prompt, then 
reenter the port number correctly.

• Under Choose Install Directory:

• (UNIX only) Specify the directory you created.

• (all upgrades) Specify your existing AccuRev installation directory.
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• (all other installation types) Specify a location where you have write permission.

• Under Choose Link Location, if you choose to create symbolic links to the AccuRev client 
programs, specify a location where you have write permission.

• (Server upgrades only) Select No when the Wizard asks, “Do you want to install a new license 
key file?”

UNIX/Linux: Unattended Installation
On a UNIX or Linux system, you can run the AccuRev installation program AccuRevInstall.bin 
as a non-interactive “console program” instead of as a Wizard.

Note: Non-interactive console installation is not available on Windows or Mac OS X.

Follow these steps:

1. Create an installation configuration file by copying the sample text below.

2. Revise the settings in the configuration file, as appropriate for the target machine.

3. Invoke the installation program as follows:
sh AccuRevInstall.bin -i SILENT -f <full-pathname-of-config-file>

You must use a full pathname to specify the installation configuration file.

Use the following text as a template for the configuration file:
###
### AccuRev InstallAnywhere SILENT installation config file
###
#
# UNIX/Linux usage:  sh AccuRevInstall.bin -i SILENT -f <config-file>

# Enables use of this config file; do not change.
INST_ROOT=true

# Location of AccuRev installation directory (OK to already exist).
# Installer creates subdirectories bin, doc, jre, etc.
USER_INSTALL_DIR=/opt/accurev

# Type of installation to perform:
# Client: Installs AccuRev Client software on this machine.
# Server: Installs AccuRev Client and Server software on this machine.
# Un-comment exactly one of the following lines.

#CHOSEN_INSTALL_SET=Client
CHOSEN_INSTALL_SET=Full

# Client install: hostname of machine to run AccuRev Server process.
# Full install: this setting ignored, hostname of local machine used.
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SERVER_HOSTNAME=myhost

# The traditional port for the AccuRev Server is 5050. But you can
# change it to any number. We recommend the range 5000 - 6000.
SERVER_PORT=5050

# Full install: full pathname of a valid license key file.
# installer copies this file into site_slice dir, as "keys.txt".
LICENSE_KEY_FILE=/path/to/license-key-file

Note: For USER_INSTALL_DIR, you must select a directory that is local to your machine. 
The AccuRev data repository cannot be located on a disk that is accessed over the network 
by the AccuRev Server process.

Installing the Software — “Custom” Installations
“Custom” installations are not that different than “Typical” installations, except that they prompt 
you to specify more information instead of assuming default values. For example, “Custom” is a 
good choice if you wish to specify a particular, non-default installation directory for the Accurev 
software. Also, if you wish to install the AccuRev Web UI Server for the first time (which is not 
done by a Typical installation), you should specify “Custom”.

When you choose “Custom” at the beginning of an installation process, you are presented with the 
following options:

• Server/Client/WebUI — Install the AccuRev Server, the AccuRev Client, and the Accurev 
Web UI Server. Note: Make sure that you really want to have both the AccuRev Server and 
the AccuRev Web UI server (with Apache Tomcat web server) running on the same host. This 
can be fine for evaluation installations, but is not recommended for production installations.

• Server/Client — Install the AccuRev Server and the AccuRev Client.

• WebUI — Install only the AccuRev Web UI Server (includes an Apache Tomcat web server 
installation). 

• Client — Install only the AccuRev Client.

For Server/Client and Client installations, refer to Installation Wizard Notes for “Custom” 
Installations on page 11 for assistance with various prompts. 

For WebUI installations, refer to Installing the Web UI Server below.

For Server/Client/WebUI installations, refer to both as needed.

Installing the Web UI Server
If you wish to install the AccuRev Web UI Server, choose “Custom” install, and then either 
“Server/Client/WebUI” (if you also want to install or upgrade an Accurev Server), or WebUI (if 
all you want is the Web UI Server).
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Note: The Web UI options are for administrators who need to install the Web UI server. If you are 
an end user just looking to use the Web UI client, do NOT use these options. To use the Web UI 
client, you simply need to bring up a supported browser and point it to an existing Web UI server 
using information provided to you by your administrator.

The Web UI server installation options install not only AccuRev Web UI Server software, but also 
an Apache Tomcat web server. If you already have an Apache Web Server on your machine, you 
should download and install the separate Web UI installation package from the AccuRev web site. 

Make sure to consider variables such as disk space and system performance before deciding to 
add a web server to this machine. 

After the installation is complete, see the installation directory for AccuRev Web UI Release 
Notes (typically 
<accurev_install_dir>/WebUI/AccuRevWebGUI_Install_Release_Notes.pdf ). 

Note: The installation section of the Accurev WebGUI Installation and Release Notes applies only 
to standalone installations, and does not apply to a Web UI installation done with the AccuRev 
Installation Wizard. However, post-installation information such as configuring Linux servers to 
automatically run Tomcat and the Web UI server upon boot-up are still valid.

Installation Wizard Notes for “Custom” Installations
Here are the prompts that you may encounter when you choose a “Custom” installation:

• Where would you like to install? — Specify a different directory if you do not want to use 
the defaults (/opt/accurev on Linux/UNIX, C:\Program Files\AccuRev on Windows).

• Please Choose a Folder: (for the repository) — Specify a different directory if you do not 
want to use the defaults (/opt/accurev/storage on Linux/UNIX, C:\Program 
Files\AccuRev\storage on Windows). Note: Ensure that the path you specify is LOCAL 
disk storage (not a network drive) and that it has plenty of space.

• Choose a license key file — This applies to the traditional, proprietary “keys.txt” AccuRev 
license manager. For Reprise license files (“accurev.lic”), see Enabling the Reprise License 
Manager on page 12.

• Host and Port — Same as the “Typical” prompts. See Installation Wizard Notes for “Typical” 
Installations on page 8.

• PATH — Responding Yes enables the AccuRev Installation Wizard to modify the PATH 
environment variable on your system so that you do not need to specify a full path on the 
command line when using AccuRev commands. 

• Choose a Java VM — If the AccuRev Installation Wizard identifies one or more existing 
Java VM (or “JRE”) packages on your system, it gives you the choice of using one of those, or 
installing a new one. If you specify and existing JRE, AccuRev will display a message 
indicating the minimum version required by AccuRev, and ask you to confirm your choice.
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Enabling the Reprise License Manager
This AccuRev release installs both the traditional “keys.txt” license manager, as well as the new 
Reprise License Manager which supports 24-hour floating licenses and 7-day standard licenses. 
You can only choose one license manager, and by default the older “keys.txt” manager is enabled 
while the Reprise license manager is disabled. To use the new Reprise license manager you must:

1. Contact AccuRev to request Reprise licenses for your site.

2. Install the new “accurev.lic” file as specified in the instructions you receive with the file. 
(Typically, you place this file in <AccuRev-installation-dir>/bin.)

3. Start the Reprise license manager server. The easiest way to do this once is to enter rlm on the 
command line:

> rlm

For the long-term, you will want to configure your system to start the Reprise license manager 
automatically at boot time. For details, see “The License Server” section of the on-line 
Reprise License Manager End-User Guide at http://www.reprisesoftware.com/
RLM_Enduser.html

4. Edit <AccuRev-installation-dir>/bin/acserver.cnf to contain the following lines to 
specify the Reprise license manager:

### LICENSE_MANAGER = keys.txt
LICENSE_MANAGER = reprise
LICENSE_SERVER = <license_server_hostname>
LICENSE_PORT = 2375

Note: LICENSE_PORT (default 2375) is the port that AccuRev uses to communicate with the 
RLM server, and should not be confused with the Accurev PORT value (typically 5050) that 
AccuRev clients use to communicate with the AccuRev server. LICENSE_PORT is the same 
port that comes with your accurev.lic license file. If you are familiar with the older keys.txt 
license files, it is important to realize that this is different than the AccuRev PORT value that 
came with those licenses. For information about changing these port values, see the “License 
Management” chapter in the AccuRev Administrator’s Guide. 

5. Restart the AccuRev server.

For more information about the Reprise License Manager, see the “License Management” chapter 
of the AccuRev Administrator’s Guide.

Platform Support Notes
The following sections contain important notes on installing AccuRev software on specific 
hardware/software platforms:

Java Compatibility
AccuRev Version 4.9 is fully compatible with the Java 2 Runtime Environment (JRE), Versions 
1.5.x and higher. These Java versions are also labeled “J2SE Version 5” and higher.
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Mac OS X
• Be sure you have JRE 1.5 or higher installed. AccuRev does not install its own JRE on OS X, 

because Java is included with the OS X installation.

• An administrative user can choose either Typical or Custom in the AccuRev Installation 
Wizard. A non-administrative user must perform a Custom installation.

• Only the AccuRev client software is supported on this platform.

• The following is a recommended method for getting all required executables into the PATH 
for Mac OS X:

Create the following three files using "sudo":

sudo echo "/Applications/AccuRev/bin" > /etc/paths.d/AccuRev 
sudo echo "/Applications/AccuRev/bin/acdiffgui.app/Contents/MacOS" > 

/etc/paths.d/Acdiffgui

sudo echo "/Applications/AccuRev/bin/acgui.app/Contents/MacOS" > 
/etc/paths.d/Acgui

• To enable the AccuRev diff GUI tool (acdiffgui) to work stand-alone as well as from an 
IDE integration such as Eclipse, do the following:

1. Make a backup copy of acdiffgui:
cd /Applications/AccuRev/bin/acdiffgui.app/Contents/MacOS

mv acdiffgui acdiffgui.orig

2. Create a new acdiffgui file with the following content:
#!/usr/bin/perl

$cmd = "java -Duser.dir=/Applications/AccuRev/bin -Xms32M -Xmx512M -
classpath \"/Applications/AccuRev/bin/oro.jar:/Applications/AccuRev/bin/
xercesImpl.jar:/Applications/AccuRev/bin/xml-apis.jar:/Applications/
AccuRev/bin/fw.jar:/Applications/AccuRev/bin/werken.opt.jar:/
Applications/AccuRev/bin/diff.jar\" diff.DiffApp ";

foreach $arg(@ARGV){

 $cmd .= "\"$arg\" ";

}

system ($cmd);

3. Close any shells.

4. Open a new shell.

Running acdiffgui should now bring up the AccuRev graphical diff tool, and it should also 
work from within any integrated IDE.

SunOS /Solaris on SPARC Hardware
• The following non-standard C/C++ language shared libraries must be accessible, both by the 

AccuRev Installation Wizard and by the installed AccuRev executables. The pathnames 
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below show typical locations for these shared libraries, but they can be placed in any location 
that is specified in environment variable LD_LIBRARY_PATH.
/lib/libgcc_s.so.1
/lib/libintl.so.8
/usr/local/lib/libiconv.so.2
/platform/SUNW,A70/lib/libc_psr.so.1
/platform/SUNW,A70/lib/libmd5_psr.so.1

• The machine must also have Version 3.3.x of the GNU C compiler.

• Solaris requires operating system patches, as described on the Sun Java Patch Page (http://
sunsolve.sun.com).

AIX
• The following non-standard C/C++ language shared libraries must be accessible, both by the 

AccuRev Installation Wizard and by the installed AccuRev executables. The pathnames 
below show typical locations for these shared libraries, but they can be placed in any location 
that is specified in environment variable LIBPATH.
libstdc++.a
/usr/lib/libcrypt.a
/usr/lib/libgcc_s.a
/usr/lib/libpthread.a

Note: The AccuRev server requires the 4.2.4 version of libstdc++.a. (You can identify your 
current version with the command lslpp -L libstdc++.) You may need to adjust your 
LIBPATH environment variable to point to the correct version, or create a symbolic link from 
this version of libstdc++.a to the /usr/lib or /usr/local/lib folder.

• The maximum file size on AIX is 2GB; therefore the Accurev Server has a file size limit of 
2GB for database and index files.

• If you choose to use the bundled Java Runtime Environment (JRE), the installer mistakenly 
warns you that you have not chosen the bundled JRE. Complete the installation, then change 
this setting in /opt/accurev/bin/acgui.lax:
lax.nl.current.vm=../jre/bin/java

HP-UX
• The value of the tunable system parameter maxssiz (maximum stack size) for the HP-UX 

kernel must be at least 0x2000000, rather than the default of 0x800000.

Use this command to determine the current setting:
grep maxssiz /stand/system

If you must increase the value, use the SAM utility, as described on the “Reconfiguring the 
Kernel” page at:
http://docs.hp.com/en/5185-6559/ch01s01.html#cihehjcc
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• The following non-standard C/C++ language shared libraries must be accessible, both by the 
AccuRev Installation Wizard and by the installed AccuRev executables. The pathnames 
below show typical locations for these shared libraries, but they can be placed in any location 
that is specified in environment variable SHLIB_PATH.
/opt/hp-gcc-4.0.3/lib/libgcc_s.sl
/usr/lib/libpthread.1

Linux 
• Linux systems require glibc version 2.3 or higher. To determine your glibc version, run 

rpm -qi glibc in a command shell.

Linux on PowerPC (64-bit) Hardware
To ensure that the AccuRev Installation Wizard and the AccuRev GUI client program pick up the 
correct Java runtime libraries:

• Set environment variable JAVA_HOME to the full pathname of the machine's Java installation 
directory. This must be the Java implementation provided by IBM for the PowerPC 64-bit 
Linux environment.

• Start the AccuRev Installation Wizard with this command line:
sh ./AccuRevInstall.bin LAX_VM <path-to-java-interpreter>

<path-to-java-interpreter> is the full pathname of the Java interpreter under JAVA_HOME.

• Start the AccuRev GUI in a similar manner:
cd <AccuRev-bin-directory>
sh ./acgui LAX_VM <path-to-java-interpreter>

• For important information on AccuRev and 64-bit Linux configurations, please contact 
support@accurev.com.
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AccuRev 4.9 Release Notes

This section alerts you to changes made in this release, and (if applicable) any known issues or 
features that will no longer be supported in future releases. 

Changes in Release 4.9
2644 — New Update Preview filter

The Java GUI now provides an Update Preview filter in the Search pane that shows all 
changes that would happen if you were to perform an update. (This new option has been 
placed near the top of the Search pane so that it is easy to find.) You can select an element 
from this display and perform operations upon it before executing the update command. See 
the File Browser on-line help for more information. Note: The File > Update Preview menu 
option now invokes this new filter. If you prefer to retain the old behavior, you can set a 
preference from the command line: accurev setpref AC_OLD_UPDATE_PREVIEW true

6352, 8859 — pop and stat 

The pop and stat commands now accept the -t <time-spec> argument, allowing users to 
specify elements by transaction id or time stamp.

8913 — pop

The pop command has a new -D option that allows you to pop only an element without 
creating its directory structure.

9051, 21907, 22341, 22353 — merge behavior

The merge command is now smarter about simple merges, resulting in simplified display of 
merge lines in the Version Browser, and simplified change packages. For example, assume 
two developers are working in parallel on the same element, with a common ancestor, and 
there are only regular versions (that is, no patches, merges, or reversions) between the current 
versions and the common ancestor. When these are merged, the resulting version of the merge 
is rebased to point to the merged version as its basis. Also, the new basis version is added to 
the Comment field upon keep.

9584, 18328, 20626, 20956, 21090 — long pathnames on Windows

Handling of long pathnames on Windows is much more robust.

9822 — chdepot case-sensitivity

The chdepot command now allows you to change the case sensitivity of a depot (you can only 
change from case sensitive to case insensitive if the depot has no elements).

10129, 10270 — Deep Overlap GUI

The Java GUI now indicates when a deep overlap has been successfully merged in your 
workspace, and also now enables you to promote from the deep overlap display. After a 
successful merge from the Deep Overlap filter, the element appears with a status of as 
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“(kept)(member)”. You can then select and promote it to the backing stream. After the 
promote operation, it disappears from the deep overlap filter. 

10317 — Deep Overlap and stat

The default behavior of stat has changed so that deep overlaps that exist beyond a time-basis 
stream are not considered (the same as stat -o -B). This improves performance and reduces 
the amount of irrelevant information shown in the output. To display all deep overlaps, 
including those beyond a time-basis stream, use stat -fo. Also, a new "timeBasisStream=" 
XML attribute has been added. See the stat write-up in the AccuRev CLI User’s Guide for 
details. In the GUI, a new Deep Overlap Optimization checkbox (checked by default) has 
been added at the bottom of the Searches pane. When unchecked, any deep overlap elements 
that exist beyond a time-basis stream are now displayed with orange highlighting.

11390, 21912 — New Help system for manuals

A new Help system for AccuRev manuals has been added to the existing GUI Help system. 
The new Help system (available from the Help -> Manuals menu) replaces the PDF-only 
manuals in previous releases with a combined, cross-document searchable HTML doc set. 
The PDFs are still available, using a PDF button at the top of the Help viewer.

11665 — stat

The stat -b command now better handles elements that have been renamed in the backing 
stream: stat first looks up the specified filename in the workspace, gets the EID, and uses the 
EID to find the correct file in the backing stream. If the specified name is not found in the 
workspace, then the backing stream is searched. In any case, the name of the file as it 
currently exists in the backing stream is what gets displayed.

12290 — New license manager

The Reprise license manager is now available, allowing sites to take advantage of “floating” 
or “standard” licenses. See the new “License Management” chapter in the Administrator’s 
Guide for more details.

18087 — Revert by Change Package

A bug has been fixed which caused incorrect versions to be displayed in the Merge Tool 
during a Revert by Change Package operation.

18233 — LDAP authentication

LDAP authentication has been corrected so that secinfo now correctly identifies a user with a 
password as “authuser” rather than “anyuser”. 

18268 — Show Active Issues

Show Active Issues now correctly displays issues that have been applied to a child stream 
with a time basis, from a parent stream using the Change Palette.

19015 — update and replica sync

A bug has been fixed which under certain circumstances could result in a replica sync not 
occurring as part of an update operation.
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19153 — Revert By Change from workspace

You can now perform a Revert By Change package operation from a workspace.

19360, 20213 — Revert By Transaction

The GUI Revert by Transaction operation now correctly labels the display panes with 
tooltips as follows:

• Left pane – “My version (Workspace version)”

• Center pane – “Common Ancestor version (Version to revert)”

• Right pane – “Their version (Basis of version to revert)”

Also, the tooltips for some of the buttons in the toolbar have been switched (“My” and 
“Their”) to reflect these changes, and the on-line help has been corrected.

19434 — Change Palette and server_post_promote trigger

The server_post_promote trigger now captures the issue number when you send the issue to 
the Change Palette to do a cross-promote.

19555 — Promote By Issue doc

A new section has been added to the “Promote by Issue” chapter of the Technical Notes, 
explaining why multiple issues sometimes appear in a target stream after a cross-promote 
operation.

21037 — cross-links

A problem has been fixed with cross-links that could result in the error message “Multiple 
paths to element found for eid” when you try to Open, View, or Save As a file in the GUI..

21905 — hist command

The hist command has two new features:

• A new -fi (“issue”) option displays issues related to a version of an element at the time of 
the specified transaction, and a new historic_only=true XML tag has been added if a 
version is not currently the head of an issue, but was at the time of the transaction

• the -fv (“verbose”) option now lists any cpk transactions, followed by details of the cpk 
add or cpk remove operation. A new cpk= attribute will appear in the transaction tag in 
XML output.

21910 — Installer and Web UI

Options for administrators to install the Web UI server have been added to the Custom mode 
of the AccuRev installation wizard. See Installing the Web UI Server on page 10 for details.

21911 — indirect ancestry

The AccuRev Java GUI no longer displays the special icon or tooltip which indicated 
"indirect ancestry" in the Show Active Issues tab. The heuristic used to display this 
information attempted to satisfy customer use cases that turned out to conflict with each other 
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and are unresolvable. Situations which made sense in one customer's context as indirect, did 
not make sense in another customer's context.

21941 — merge in GUI with special characters

If you attempt to merge a file in the GUI and the file contains characters that are incompatible 
with your current encoding preference, a dialog now appears giving you detailed suggestions 
about how to proceed. Also, the GUI Preferences Diff/Merge tab now offers a ISO-8859-1 
encoding option, to allow you to perform a merge when there are characters in a file that 
cannot be encoded with Unicode. If you choose to use this method to complete the merge:

1. Close the dialog alerting you to the issue.

2. Close the Merge window.

3. Go to Tools -> Preferences -> Diff/Merge and change Character Encoding: to ISO-
8859-1. Click OK when done.

4. Reopen the merge window and complete the merge operation.

5. When done, SWITCH THE CHARACTER ENCODING PREFERENCE BACK TO ITS 
ORIGINAL SETTING. 

22204, 22539 — update 

The update command now only displays the error message “Move aside directory unusable” 
after first attempting to resolve the problem automatically. Here is how this feature works, and 
what you need to do if you still get a “move aside” error.

1. If update needs to resolve a namespace issue, it requires a temporary directory where it 
can copy files and work with them. This temporary directory is specified in 
<user>/.accurev/ac_tmp_map.txt. For example, on Windows XP, this might be:
C:\documents and settings\jsmith\.accurev\ac_tmp_map.txt

2. For each filesystem where there is an AccuRev workspace, this file contains a line of the 
format:
<hostname> <filesystem> <tmp_move_aside_dir>

It is important that these ac_tmp folders are on the same filesystem as the workspace that 
they support. For example, if jsmith’s computer is named “laptop_006”, and there are 
AccuRev workspaces on the C: and E: drives, these lines might resemble:
laptop_006 c:/ C:\Documents and Settings\jsmith\accurev\ac_tmp
laptop_006 e:/ E:\workspaces\accurev\ac_tmp

3. If the update command needs to use one of these directories, it first tests it to make sure 
that it is accessible. If it cannot write to this directory for any reason, AccuRev 
automatically updates the unusable line in ac_tmp_map.txt with a default of
<accurev_workspace>\..\accurev\ac_tmp. It then tests the new entry, and if it works, 
the update proceeds. 

4. However, if AccuRev is unable to use the new, default entry (typically on Linux/UNIX 
systems, and typically because a symlink causes the default 
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<accurev_workspace>/../accurev/ac_tmp location to be on a different filesystem and 
than the workspace), it displays the “Move aside directory unusable” message and does 
not proceed with the update. If this happens, you need to manually address the problem as 
described in the following steps.

5. Create a temporary “move aside” directory that resides on the same filesystem as the 
workspace.

6. Edit ac_tmp_map.txt to point to this new move aside directory. 

22232, 22377 — Show Active Issues GUI

The “Show Active Issues” display in the Java GUI has been modified: 

• The checkbox formerly labeled Include Hierarchy has been renamed to Include Child 
Streams to remove ambiguity about its purpose.

• The table at the bottom of the display now includes new Stream and Id columns to 
identify where the elements are active, and to handle cases where the element may have 
different names in different streams. This Stream information has also been added to the 
XML output of the issuelist command.

22235 — Change Palette

Change Palette: A problem has been fixed so that the "Issue" column is now correctly 
populated when you use the Active Issues icon to open the Change Palette (rather than using 
Send To Change Palette from the context menu).

22284 — Replication server licensing

If a master server is running the traditional proprietary (“keys.txt”) license manager, any 
replication server working with that master server must have a valid keys.txt file installed for 
a user to log in. If the master server is running the new Reprise license manager, no special 
license file is required on the replication server.

22297 — AccuWorkflow

In AccuWorkflow, it is now possible to easily associate an existing transition with an existing 
stage for new logical branches. For details, see the Note in the “Define the new stage(s)” 
section of the new Quick Start for Defining a Simple Workflow in the on-line help 

22322 — Issue link in AccuWork GUI

A clickable Issue link now appears at the far right of the AccuWork Issue Edit form toolbar, 
allowing you to easily capture a URL to the current issue, using the Web UI. To configure this 
feature, create or edit:
<accurev_install_dir>\storage\site_slice\dispatch\config\settings.xml 
to contain the following entry (customized for your specific installation) to point to your Web 
UI server:

<settings>

    <webui url="http://<webui-host>:<port>/accurev"/>

</settings>
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22329 — Replication servers

A bug has been fixed which could cause replication servers to hang if used with AccuRev 
clients older than Release 4.8.

22330 — diff and update

A bug has been fixed where diff and update were not seeing changes from a stream with a 
cross-link to a stream hierarchy with a time basis.

22569 — Show Active Issues and unaffiliated changes (“dark matter”)

If you select an issue marked as “NONE” in the Show Active Issues pane, you can now 
perform a Send to Change Palette operation on it, and the correct elements are placed on the 
Change Palette. Note that Promote Issue(s) is now disabled when “NONE” is selected.

Known Issues
21829 — Chrome browsers and Help

Recent Chrome browsers do not work with on-line Help systems. See AccuRev 4.8 Release 
Notes on page 22 for details.

Deprecated Features
• Support for AccuRev servers on HP-UX and IBM AIX operating systems will be 

discontinued after this release. Accurev clients will still be supported on these platforms. 

• Support for Windows 2000 was officially discontinued after the V4.7 release (as announced in 
the v4.7 Release Notes in 2008). Although AccuRev's Windows binaries may still have 
installed and run in later releases, this will no longer be the case for V5.1 and beyond. Existing 
Windows 2000 client-side users must upgrade to one of our supported Window platforms as 
highlighted at http://www.accurev.com/accurev_support_matrix_5_0.html

• Support for the “traditional” authentication method will be discontinued in a future release of 
AccuRev. If you still use traditional authentication, please switch to “accurev_login” or 
“custom” authentication. Please see the “AccuRev Security Overview” chapter of the 
AccuRev Administrator’s Guide for information about authentication methods.
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AccuRev 4.8 Release Notes

Please read these notes to familiarize yourself with the changes in AccuRev 4.8. 

Issues Fixed
3670

When update detects that it has run out of disk space, it now stops cleanly with an 
“incomplete update”status and reports the “out of disk space” error to the user. 

5127, 8329, 18792, 20625, 21212, 21321

Update has been enhanced to better handle situations that used to result in “File Busy” 
failures. Fewer scenarios result in failures, and those that do now return descriptive error 
messages to help you troubleshoot and correct the problem.

5832, 21639

More change package history has been made available to the cpkhist xml command,. The 
expanded history now specifies whether the action was related to a cpkadd or cpkremove 
operation, and the cpkremove information now supplies the name of the element, not just its 
eid. This Change Package history is now available in the Java GUI from a new icon on the 
Issue Edit Form toolbar. 

7117

In the GUI, lock status now gets updated when you refresh the Stream Browser.

12645

Change packages no longer incorrectly appear as “missing” after reverting by change 
package.

14299

Update progress bar: In certain situations, particularly on Linux, the progress bar would 
incorrectly display the percentage complete and not disappear at the end of the update. This 
problem has been fixed.

14616

Update no longer gets confused after two directories have been inverted (for example, 
directories “a/b” get moved and renamed so that the contents of “b” end up in “a”, while the 
contents of “a” end up in “b”).

14621

Update no longer incorrectly leaves external files when executed after a rename operation.

14829

A bug has been fixed which caused change packages on a replica server to not display an issue 
number.
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14928

A Help button has been added to the dialog that displays the promote warning "Promote failed 
due to coalescing problem". Clicking on the Help button displays a Help browser describing 
the problem and how to resolve it.

16491, 21720

Promoted elements that are not associated with an issue (“dark matter”) now are visible in the 
stream. The xml issuelist and issuediff commands now support a new 
show_unaffiliatechanges=true attribute and generate extra output with a list of all the 
unaffiliated file changes. In the GUI, a row for the unaffiliated changes (displayed as “NONE” 
with a black background) has been added in the Show Active Issues table. See the 4.8 on-line 
help for details. 

17373, 19155

Update no longer fails with an incorrect 'Element has moved:' error, which sometimes 
occurred when dealing with case-sensitive operating systems and case-insensitive depots.

17879

Send to Change Palette now correctly handles target directories that cross-link back to 
source.

19410

Update now correctly handles the following case:

1. A workspace contains an active file under some directory. 

2. One transaction moves the directory to a new location 

3. A subsequent transaction excludes a directory that is an ancestor of the old path before the 
move.

Prior to this fix, AccuRev would complain that the active element would become stranded, 
because it was looking at the old name rather than the new name of the active element.

20045

Update has been corrected so that updating xlinks no longer results in missing files,.

20182

An issue has been corrected which caused malformed XML (redundant closing tags) to be 
generated from the command accurev hist -p <stream> -fx -t<trans>

20341

Change package behavior has changed so that when you add a merged version to a change 
package, the basis version of the change package is modified to be the common ancestor of 
the merged version.
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20516

When updating a workspace which included files that had been archived, the GUI would 
report “Update failed” when it actually succeeded. The GUI now reports that update has 
succeeded

20733

It is now possible to promote all active elements up to and including a given transaction, using 
the syntax promote -t <transaction> -d.

21039

Issue Diff now correctly shows an issue that only has a defunct file attached to it.

21048

Promote by transaction and by change package now ignore element versions that are already 
in the destination stream

21050

Promote by transaction and by issue now purges elements from the default group if those 
elements are the same version as the backing stream. By ignoring all elements that are the 
same version as in the backing stream, redundant virtual versions are not created in the 
backing stream. 

21058

The “Dependent Issue” column in the Issue Dependency Details panel has been enhanced. 
The bottom pane of the "Issue Dependencies" tab now provides a combo box with two entries:

• "Show Issue(s) That The Selected Issue Depends On"— Default. New behavior.

• "Show Issue(s) That Are Dependent On The Selected Issue”— Old behavior.

The old "Dependent Issue" column has been renamed to either "Selected Issue Depends On 
Issue(s)" or "Issue(s) Dependent On Selected Issue" depending on what is selected in the 
combobox.

21585

The Issuelist command now only considers eids in the default group, which improves 
performance.

21685

A problem has been fixed with show -s where a time basis could return incorrect results or, in 
certain cases, cause an infinite loop.

21733

The Update “file busy” error now causes the GUI to display a descriptive error message.
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21738

A new View Log File button has been added to the “Update Failed” warning dialog, helping 
you to identify and correct problems that prevent Update operations from completing.

8753, 16562, 20805, 20813, 21492, 21560 - 21566, 21568, 21570, 21571 

Several customer-reported documentation issues and enhancement requests have been 
addressed, including typos, missing or incorrect details, and expanded explanations. Also, the 
Command Reference PDF now provides running headers across multiple pages of command 
descriptions, identifying which command is being discussed.

21492

Configuration information for Mac OS X platforms has been enhanced in the AccuRev 
Installation Notes.

Known Issues
22204

On Windows Vista and Windows 7 the update command may fail with a “Move aside 
directory unusable” error. If this happens, delete the ac_tmp_map.txt file in your HOME/
.accurev directory and try again.

21829

Recent Chrome browsers do not work with on-line Help systems (see http://
code.google.com/p/chromium/issues/detail?id=47416). A security enhancement to 
Chrome browsers in June 2010 has caused problems in several on-line Help systems. In 
AccuRev’s case, the left-hand navigation pane is blank, and it is impossible to display the 
Table of Contents, Search, and Glossary tabs. Possible workarounds include:

• rolling back to an older version of Chrome

• using a different browser

• disabling the security feature in the AccuRev preferences

• disabling the security feature system-wide

Google has provided a command line switch to disable this new security feature. You can try 
disabling this feature just for AccuRev Help, by using the following procedure:

1. In the AccuRev GUI, go to Tools, Preferences

2. In the On-line Help Browser field, specify the start-up command line for Chrome with the 
“--allow-file-access-from-files” argument (Windows example shown):
"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" --allow-file-access-from-
files "%1" 

If this does not work for your installation, another option is to try using this switch as the 
default for all instance of Chrome on your system. The following example shows how to use 
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this fix in Windows. Adjust appropriately for other operating systems. The following 
procedure assumes that you have Chrome set as your default .htm/.html browser:

1. Open Windows Explorer.

2. Navigate to Tools => Folder Options => File Types

3. Select "HTM" or "HTML", then click Advanced. 

4. Select Open, then click Edit...

5. In the "Application used to perform action:" field, you should see a line similar to:
"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" -- "%1" 

6. Replace the empty "--" with "--allow-file-access-from-files":
"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" --allow-file-access-from-
files "%1" 

7. Click OK, OK, and Close to save your changes and exit out of the dialogs.

Of course, if this line has already been customized at your site, you will need to adjust the 
above instructions as needed.

Also, note that implementing this fix will disable a security change introduced with Chrome, 
so the security policies of some organizations may prohibit them from doing this.

Deprecated Features
Support for the “traditional” authentication method will be discontinued in a future release of 
AccuRev. If you still use traditional authentication, please switch to “accurev_login” or “custom” 
authentication. Please see the “AccuRev Security Overview” chapter of the AccuRev 
Administrator’s Guide for information about authentication methods.
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